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About this course
Objectives of the course
Upon completion of this course you will learn how to 
- Use Human Model technology in order to leverage your ergonomics
analysis.  
- Position and manipulate the manikin within a V5 Scene. 
- Evaluate the comfort, the reach, clearance, and the vision of your target 
population.

Targeted audience
Designers, Engineers, Human factors specialists, Any Health specialists, 
V5 Users.

Prerequisites
Students attending this course must have knowledge of V5 Digital Mock-up.

16 hours
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Product Overview
The V5 Human product is a scalable solution that is 100% embedded inside the V5 
Architecture. The solution is divided into 4 interacting components: The main product 
(HB) and 3 add on. With these tools, the user is able to perform sooner and in a more 
efficient manner the different level of ergonomics assessment.
Let’s explore together this solution and these products (workbenches) in more details.

Human Builder

Human Activity Analysis

Human Posture Analysis

Human Measurements Editor
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Human Builder (1/2)

Human Builder is based on a best-in-class human modeling system which, for many 
years, has permitted detailed investigation into human-centered design issues in the 
context of a workplace before it physically exists.
Human Builder provides very accurate simulation of humans and their interactions 
with products to ensure they will operate naturally in a workplace tailored to their 
tasks.
The Human Builder product specifically focuses on creating and manipulating digital 
humans for 'first level' human-product interaction analysis.
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Human Builder (2/2)

Human Builder consists of a number of advanced tools for creating, manipulating and 
analyzing how manikins (based on the 5th, 50th and 95th percentile value) can interact 
with a product. The manikins can then be used to assess the suitability of a product for 
form, fit and function. The manikins can be intuitively created and manipulated in 
conjunction with the digital mockup to check features such as reach and vision. A 
simple-to-use interface ensures that first-level human factors studies can be 
undertaken by non-human factors specialists.

Tools contained within the Human Builder product include manikin generation, gender 
specification, percentile specification, direct Kinematics and Inverse Kinematics 
manipulation techniques, animation generation, Constraint, Simulation, Replay, Reach 
envelope, Attach-Detach, Coloring, Monocular, binocular and ambinocular vision, as 
well as vision output cones.
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Human Measurement Editor (1/2)

Human Measurements Editor is based on a best-in-class human modeling system for the 
calculation of anthropometric correct manikins. This product allows any users ( even non 
specialist) to generate specific manikins of specific dimensions in order to represent the 
target population. Two approaches can be explored: generating a specific manikin to 
represent one specific individual, or create a series of manikins that reflect all together a 
defined percentage of a population.
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Human Measurement Editor (2/2)

The Human Measurements Editor specifically focuses on creating detailed digital 
humans for advanced human factors analysis and global target audience 
accommodation.

In addition to six default manikins, Human Measurements Editor users can create any 
human being from any population anywhere in the world. Users can amend all 103 
anthropometrics variables on the manikin or manipulate a smaller number of 'critical' 
variables and ask the Human Measurements Editor to determine the rest. These 
variables can be altered manually by inputting desired measurements in percentile 
value, unit measurement, or by an intuitive 'click and drag' graphical user interface.

The Human Measurements Editor also has the capacity to define the mean and 
standard deviation of all anthropometry variables. Using a unique multi-normal 
technique, the Human Measurements Editor ensures that resultant manikins do exist 
in the target population. In addition, it is possible to specify the percentage of the 
population to be accommodated in the design using the boundary manikin technique.
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Human Posture Analysis (1/2)

Human Posture Analysis offers the ability to evaluate (quantitatively) the posture of 
manikins. Human Posture Analysis focuses on how human posture can affect task 
performance by analyzing local and global postures, preferred angles, and 
comfort. It also allows the users to create manikins with limited range of motion 
either created by the age, an handicap or rigid equipment (ex heavy clothing).
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Human Posture Analysis (2/2)

Human Posture Analysis permits users to quantitatively and qualitatively analyze 
all aspects of manikin posture. Whole body and localized postures can be 
examined, scored, iterated, and optimized to determine operator comfort and 
performance throughout the complete range of task motion in accordance with 
published comfort databases.

User-friendly dialog boxes provide postural information for all segments of the 
manikin. Color-coding techniques ensure that problem areas can be quickly 
identified and iterated to optimize posture. Human Posture Analysis allows users 
to create specific comfort and strength libraries to meet the needs of individual 
applications
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Human Activity Analysis (1/2)

In the demanding global marketplace, ensuring that human fit, form, and function are 
comprehensively addressed is becoming an increasingly important aspect of design.
Human Activities Analysis specifically focuses on how a human will interact with objects in 
a working environment, as well as the effects of lifting, lowering, pushing, pulling and 
carrying on task performance. 
This tool allows to validate if the tasks performed by the manikins are respecting the 
ergonomics standards currently recognized by the market.
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Human Activity Analysis (2/2)

Human Activity Analysis evaluates all elements of human performance from static 
posture analysis to complex task activities. Human Activity Analysis possesses a 
range of tools and methods that specifically analyze how a manikin will interact with 
objects in the virtual environment. 

The NIOSH 1981/1991 and Snook and Ciriello (Known as Snook table) equations 
measure the effects of lifting/lowering, pushing/pulling, and carrying to fully optimize 
task performance. A designer can determine a number of task variables such as action 
limit, recommended weight limit, and maximum lifting/lowering weight. Benefits 
include accurately predicting human performance, ensuring conformance to health 
and safety standards and maximizing human comfort and safety.

Together, these tools provide designers with a comprehensive, quantitative and 
intuitive capability to design products that reflect the key skills as well as the 
limitations of the target audience.
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Introduction to Human Tools
In this lesson you will learn the general Human Concepts: 

Specific settings for Human Modeling will be seen before each Workbench

• General Settings 
• Useful Keyboard shortcuts
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General Settings (1/3)

Remove 
automatic saving

Define path 
for document

Add the path

1

2

3
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A. Pre select on geometry 
view

B. Manipulation Box

C. Gravitational effect Z

D. Animation

General Settings (2/3)

A

D

C

B
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General Settings (3/3)

B. Setup the Units

A. Set the level of accuracy 
and performance
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Useful Keyboard Shortcuts

Down arrow……. Relocate the graph 1/10th 
(one tenth) of a page to the 
bottom

Left arrow……… Relocate the graph 1/10th 
(one tenth) of a page to the 
left

Right arrow……. Relocate the graph 1/10th 
(one tenth) of a page to the 
right

Ctrl + Tab……… Swap active document 
windows

Alt + Enter…….. Run the Properties... 
command

Ctrl + C………… Run the Copy command
Ctrl + F…………. Run the Search... command
Ctrl + G………… Run the Selection Sets... 

command
Ctrl + N………… Run the New... command
Ctrl + O………… Run the Open... command
Ctrl + P…………. Run the Print... command
Ctrl + S…………. Run the Save... command
Ctrl + V………… Run the Paste command
Ctrl + X………… Run the Cut command

Escape10……….. Exit the current dialog 
box (when there is one)

F1……………….. Get contextual online help
Shift + F1……….. Get help on toolbar icons
Shift + F2……….. Toggle the specification 

tree overview on and off
F3……………….. Toggle specification tree 

display on and off
Alt + F8…………. Run macros
Shift + F3……….. Activate the graph is the 

model is active and 
inversely

Home…………… Display the top of the graph
End……………… Display the bottom of the 

graph
Page Up………… Relocate the graph one 

page up
Page Down……... Relocate the graph one 

page down
Ctrl + Page Up…. Zoom In the graph
Ctrl + Page Down Zoom Out the graph
Up arrow………. Relocate the graph 1/10th 

(one tenth) of a page to the 
top
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Manikin inside a 3D Context
You will become familiar with the manipulation of the manikin :

Specific settings for Human Modeling will be seen before each Workbench

• Introduction of the Human Activity Analysis workbench 
• Defining the Settings
• Human Builder Toolbars
• Manipulating Manikins
• Kinematics
• Creating links between manikins and geometry
• Using Catalog
• Analyzing Vision
• Creating a Reach Envelope and a Swept volume
• Analyzing clash
• Performing simulation
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Accessing the Human Builder Workbench

This workbench focuses on creating and manipulating manikins for 'first level' human-
product interaction analysis. Based on the 5th, 50th and 95th percentile value of a manikin, 
you can analyze the interaction with a product.

You can access the workbench from Start > Ergonomics Design & Analysis > Human Builder
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Human Builder - Settings

A. Define if you want the 
constraint to be update 
automatically

B. Activate the twin segment 
activation

C. Activate the look at function

D. Define the reference of the 
angle of a segment

E. Enable the Report ID

F. Define if you want  to lock 
the grasping motion of the 
selected fingers when 
selected

G. Define if you want to save 
manikin specific attributes 
on instance or also on the 
reference

G

F

E
D

C

B

A
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Human Builder Toolbars (1/2)

These are the toolbars and icons for

Inserts a new manikin 

Inserts a new load 

Inserts a new Report

Inserts a new offset 

Changes the display of a manikin 

IK Behaviors 

Adds a description to a manikin object 

Open Vision Window 

Computes a Reach envelope 

Attach/Detach 

Load manikin's attributes from a catalog 

Save manikin's attributes in a catalog 
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Human Builder Toolbars (2/2)

Posture 
Editor

Forward Kinematics

Inverse Kinematics 
Worker Frame Mode

Reach (position only)

Place Mode

Standard Pose

Hand spherical posture

Hand cylindrical posture

Hand pinch posture

Execute auto grasp

Contact Constraint

Coincidence Constraint

Fix Constraint

Fix On Constraint
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Preparation of a 3D Scenario

1. By selecting File/Open in the main menu, 
Open the desired CATProduct in the file 
selection dialog box.

2. To Insert an existing component select the 
parent product in the specification tree, 
right click and select insert an existing 
component 

3. To move a part inside a 
CATProduct, you have to double 
click on the parent product to be 
able to move the child. 
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1. Insert a manikin 
using the 
following Icon

2. Select Details
Father product  
Name
Gender
Percentile

3. Select the Option
Population
Model
Referential

4. Drag the compass 
at the destination 
prior to insert the 
manikin.

Moving and Manipulating Manikins (1/4)

Integrating a new Manikin
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Moving and Manipulating Manikins (2/4)

1. Insert in the current V5 Scene a 
manikin that already exist in a 
file.

2. Select a file that contains a 
manikin and click Open.

Integrating an existing Manikins

A manikin is always inside 
a CATproduct file
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Moving and Manipulating Manikins (3/4)

A. The manikin tree is 
divided in three sections. 

B. Under the Profiles or for 
any specific segment, 
you can change the 
properties of the manikin. 

C. Using the contextual 
menu, you can have 
access to the Properties 
of segment. 

Manikin Tree Organization

B

C

A

A

A

Changing the Manikin’s 
Properties
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1. When creating a 
manikin, it’s possible to 
define the exact location 
using the referential.

2. Once created, the 
compass is the primary 
mode to move the 
manikin. Drag the 
compass on the manikin, 
select the manikin in the 
specification tree and 
change it’s position.

3. The place mode function allows 
also to position the manikin on 
a specific location. (the Z only 
directly aligns the z-coordinate 
of the manikin’s referential with 
the object selected)

There are many ways to Move (change position) the Manikin in the scene:  At the 
Creation, Compass, Place Mode and Manipulation Box.

4. Finally, if activated in the tools 
> options, the manipulation 
box is a rapid way to move the 
manikin.  Unfortunately,  it 
does not supported the 
rotation since you can only us 
the edges.

Drag the compass 
on a surface and 
select the manikin

Once snapped on 
the manikin, use the 
green edges or arcs 
to move the manikin

Moving and Manipulating Manikins (4/4)
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1. Select the segment of the 
manikin and activate the 
forward kinematics icon.

2. With the left mouse button, 
drag the selected segment so 
that the mouse cursor follows 
the arrow.   By default, the 
movement exerted will be done 
according to DOF1 (Degree of 
Freedom 1).

3. Change the DOF by clicking on 
the right mouse button .

4. Once the desired posture has 
been obtained  you can select 
the segment and use the right 
click button 
Reset  Mirror copy
Swap copy

There are mainly two types of manipulation for the manikin.  The first is the forward 
kinematics where the segment is controlled directly

Kinematics (1/7)

Forward Kinematics
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1. Select the segment of the manikin and 
activate the Posture Editor function. 
Segment can also be selected inside 
the panel.

2. With the cursor, slide the button in 
order to change the posture.  You can 
also input a specific value.

3. Change the DOF directly in the DOF field.

4. Change the point of view automatically and 
display the angular limitation directly on the 
segment.

5. Change the side.

6. Change the direction of the movement.

7. Change the posture automatically to 5 default 
posture.  Check for the referential point 
selected when created the manikin

Forward Kinematics
For the forward kinematics, the Posture Editor panel allows accurate manipulation.

Kinematics (2/7)

The reference of the angle can be modified in 
the option (p19). You can use zero ( as 
considered fully extended ( No flexion) or 180 
degrees fully extended

7

6

5

4

3

2

1



Student Notes:

Human Modeling
����������	��

Copyright DASSAULT SYSTEMES 32

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

1. Select the Standard Pose 
function and click on the 
manikin.

2. There are several tab that 
allows to move several part or 
segment of the manikin.

3. For the stoop, 
specific portion of 
the spine can be 
selected.

Standard Pose
For the forward kinematics, the Standard pose allows to move the manikin with some 
Inverse kinematics components.

4. Temporary constraint (IK mode) can be 
activate in order to maintains segment 
location while changing the posture of 
the manikin.

5. Activate the view point mode so 
the best point of view is 
displayed.

Kinematics (3/7)

5

4
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Kinematics (4/7)

Standard Pose – Auto Grasp

1

It’s possible to use a separated toolbar for auto 
grasp.  

By using View > Toolbar > Manikin Hand Grasp

2

3

4

5

6

Select the Standard Pose function and click on the manikin

Select the Hand Grasp tab

Select the desired type of grasp and click on the manikin’s hand

Select the object and click on the Auto Grasp icon

You can maintain the auto grasp activated and use 
the reach and IK in sequence. In the tools options, 
you can activate a feature that would lock the 
selected segment.  

This is useful once the hand is closed and you want 
to modify the grasp except for the selected fingers
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1. The reach mode is easily accessible by 
clicking the Reach icons.

2. The are two modes of reach

Position only
Position & orientation 

3. Select the segment you wish to use for 
the reach and click on a target (a white 
compass appears automatically).  Use 
the arc of the compass to fine tune the 
posture .

4. If the object is out of reach, the twin 
segment will display and the missing 
value will be shown.

5. In the tools > Option > Human Builder > 
Display, the option of the display for the 
twin segment can be modified.

When using the position 
& orientation reach, 
most of the time you 
need to readjust the 
orientation using this 
specific arc of the 
compass. 

Inverse Kinematics
When using Inverse kinematics of the manikin, there are three mode mainly use in order 
to move the manikin, Reach, IK mode and the Constraint: Reach

Kinematics (5/7)

The reach can be used for every segment of the manikin. Also you can 
use CTRL button to select  multiple segment.



Student Notes:

Human Modeling
����������	��

Copyright DASSAULT SYSTEMES 35

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

5. In the tools > Option > Human 
Builder > Display, the option of 
the display for the twin segment 
can be modified.

1. The reach mode is easily accessible by clicking the IK Mode icon.

3. Select a kinematics chain and 
the compass will snap the its 
end-effectors (See 7 control 
points in the note below). 

2. There are two modes of Inverse 
Kinematics Mode:  
Segment frame

Worker Frame

Using the 3D mouse 

4. Use the compass to position the 
hand at the desired position.  

When using the 
position & orientation 
reach, most of the 
time you need to 
readjust the 
orientation using this 
specific arc of the 
compass. 

Inverse Kinematics
When using Inverse kinematics of the manikin, there are three mode mainly use in order 
to move the manikin, Reach, IK mode and the constraint: Inverse Kinematics  IK Mode

The compass is aligned 
with the segment

The compass is aligned with 
the hip of the manikin

For example select the arm and the 
hand twins (Yellow) will be highlight 
with the compass.  A temporary 
constraint will be create end the 
hand will try to match the position 
and the orientation of the Twin

Kinematics (6/7)

The IK mode can be used only by seven 
control points on the manikin ( 2 Hands, 2 
Feet, Hip, Neck and line of sight )
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4. The Spine section 
allows to involved Or 
Not some trunk 
component when using 
the IK.  If not activated, 
only the arm kinematics 
segment will be used

1. Call the IK Behavior using the 
following Icon:

2. In the specification tree, 
you also get the 
Properties of the IK 
behavior.

3. Check several combination, start by using the IK 
Mode, select both leg (Activate Feet twins) and 
then select the hand and drag the hand twin

When using the IK function of the manikin ( Reach, IK mode or the constraint) 
the IK behavior allows to change the way the manikin reacted

Kinematics (7/7)

7. The Optimization section Help to automatically find 
better postures according to criteria such as the 
Postural Angles (Scores) or the Rapid Upper Limb 
Assessment (RULA)

5.

5.

6.

6.

6.
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Creating Links between Manikins and Geometry (1/4)

1. Once integrated in the file, any object can be attached to any 
manikin’s segment. Select in sequence; the Attach icon, the 
object and then the segment.

2. If the object is already attached 
to a segment, a warning 
message will ask if the user want 
to attach to other object or 
simply detach it.

3. At any time, the status of objects 
attached to the manikin can be 
verified by clicking on the 
properties of the attaches Node 
in the specification tree.

If the segment is moved and the 
object is attached to this segment, 
the object will follow. However, if 
the object is moved, the segment 
does not follow.
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The Offset command is used to redefine the behavior of the Reach Mode. Reach Mode 
default behavior is used to make the end point of the selected segment reach the 
compass location. The offset command, therefore, allows you to transfer that 'end point' 
to a different point in 3D space.
1. Select the icon, and click on the hand 

that has an attached object :

2. In the panel , input the coordinates of 
the offset OR position directly the 
compass at the desired offset using 
the red box of the compass (Example 
move the compass to  tip of the tool) 
and then click OK

3. You can create several offset of the 
manikin on the same tool or on 
different tool he will use.  Only one 
at the time can be used (activated)

Example of offset 
for the forearm and 
the reach function

Creating Links between Manikins and Geometry (2/4)
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2. In order to create a constraint, simply select the type of 
constraint, select the segment and select the object or 
the components of the object  ( Point, line or plane).          

When using Inverse kinematics of the manikin, the two first mode presented 
previously are temporary.  If you deactivate the function, the constraint are 
removed.  It’s possible to make these constraint more persistent: Constraint 

3. In the tools / Options, the display of the constraint can 
be modify according to its status.         

Creating Links between Manikins and Geometry (3/4)

Allow to have the selected segment that coincide with a line or a plan.

Allow to have the selected segment in contact with a line, a plan or a 
point.

Allow to have the selected segment at a Specific location in the space.

Allow to have the selected segment at a specific location in relation with a 
selected object.

Fix on

Fix

Contact

1. There are four different type of constraint:      

Coincidence
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Creating Links between Manikins and Geometry (4/4)

4. In the Specification tree, each constraint are 
accessible, using the contextual menu, you 
can get the properties or change the status 
directly. 

In the tools > Option > Human > Builder >  Display, 
select if you want to have the constraint updated 
automatically when moving an object  OR 

only after you click on the update button.
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Using Catalog (1/2)

1) From the Specification 
tree, select the attributes 
to be saved. 

2) Select the save manikin’s 
attributes in catalog.

3) Select the desired catalog 
or creates a new one with 
the Browser icon.

4) Enter a title for the 
manikin attributes that are 
about to be saved. Click 
on Save. The catalog 
browser is updated, 
displaying the new 
posture/set of attributes 
that have been saved.

2. The attributes saved 
inside the catalog can 
also be apply on the 
manikin with the icon 
load manikin's attributes 
from a catalog.

Manikin  Tree Organization

1

1

2 32

1.

Manikin tree organization

You need to be specific on what 
attributes has to be saved  and for 
which segment. If the manikin node 
is selected, the attribute for every 
segment will be stored. The reverse 
process is identical.
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Using Catalog (2/2)

Create a catalog

Keyword : This item is an attribute describing chapter and family content. Keywords are user-defined. 

3

4

5

6

1 2OR When you use the function 'Save Manikin’s attributes in a 
catalog' click on 'Browse another catalog', select the 
desired location and type a new name for a catalog. This 
will create a new catalog.A catalog is a structure composed of the following items:

For every catalog, there is a 
.catalog file and a .CATSwl file. 
Those two files must always be 
together because the CATSwl
contains all the attributes data. 

7

Chapter : This item is a method for categorizing the sub-items contained within

Family : This item is a set of components

Part Family : This item is a set of components referring to a .CATPart document. Part Families are                       
assigned different sets of parameters values that are managed by a design table.

Component : This item is a reference to an external document or entity and is described by keywords.
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1. The vision is available either by 
double clicking on the vision node in 
the specification tree 

or selecting the Vision Icon.

2. Once the vision window is open, you 
can edit using the contextual menu by 
right clicking on the window.

3. In the option, all color of the vision 
display can be modified

Analyzing Vision (1/2)
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Analyzing Vision (2/2)

4. In the properties of the vision, 
all parameters can be adjusted

5. By changing the display of the 
manikin, the line of sight can be 
accessible and used as a 
normal segment
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1. Click on the report Icon and select the manikin.  A 
new report will be added in the specification tree:

2. Using the contextual menu or by double clicking on the 
report, select the analysis that needed to be reported.

4. In the specification tree, the contextual menu 
allows also to deactivate the report

Ergonomics analysis, constraints result and vision can be efficiently shared 
using the Report function

6. In tools > Option > Human > Builder > General, 
the naming function can be activated so a name 
can be added every time a report is refreshed

3. The report can also be updated using the 
updated button.

5. Select the path for the output and 
the format (suggested HTML)

Report Definition
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1. Select a segment of the hand 
and activate the reach envelop 
function.

3. A similar function can be also 
analyzed fir the segment:  Swept 
volume

2. The reach envelop for this 
specific segment will be 
automatically calculated.

The Reach Envelope function evaluates the manikin's arm reachability and the Swept 
volume icon generates the volume that is occupied by the manikin’s segments movement.

4. Select the segment you 
want to include in the 
analysis.

5. Move  the manikin using any functionalities 
available ( from FK, IK simulation, etc.) Then 
click on stop recording swept volume button

6. Check the preview.

The reach envelop does not include the movement 
of the trunk (no matter the option of the IK 
behaviors but it does take into consideration the 
angular limitations

7. Both analysis can be exported 
and insert in the scene.

Creating a Reach Envelope and a Swept Volume



Student Notes:

Human Modeling
����������	��

Copyright DASSAULT SYSTEMES 47

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

Analyzing Clash (1/3)

The clash analysis analyzes interactions between products and 
determines the existing clash.

Select the item you want to monitor for 
collisions. 

1 2 Select the Clash icon 

3 The Check Clash dialog box 
appears.

4 Depending of the scenario, chose the appropriate 
type of clash you want to determine.

Checks whether two items 
occupy the same space and 
whether they are in contact.
In addition to checking 
whether the two products or 
resources occupy the same 
space zone, and whether 
they are in contact, this 
option checks whether they 
occupy a clearance zone 
around each other. 
Checks whether an item 
penetrates another object 
beyond a user-specified 
amount. 

Allows you to use Knowledgeware 
capabilities for clash. 

Checks for collisions per specifications 
set in the Type pull-down menu occurring 
between two selected products or 
resources.

Checks for collisions per specifications 
set in the Type pull-down menu. This is 
the default setting.

Checks for collisions per specifications set 
in the Type pull-down menu that are 
caused by a selected product or resource.

Checks for collisions per specifications 
set in the Type pull-down menu for a 
selected product or resource.

Contact + Clash

Clearance + 
Contact + Clash

Authorized 
Penetration

Clash Rule

Between All 
Components

Inside One 
Selection

Selection 
Against All

Between Two 
Selections
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Analyzing Clash (2/3)

7

If an object is already attached to the manikin, this object will be considered as a sub 
element of the manikin.  Therefore, it’s possible to detect the collision between the tool 
handle by the manikin and another object.

5

Clash analysis data is stored in the Product tree within the Application node6

You can review clash results, by clicking the Results 
Window button.

8 If there are clashes, they will be listed in the Check 
Clash dialog box. 
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Analyzing Clash (3/3)

1 The elements involved in the collision will 
be highlighted in the 3D viewer by 
activating the Clash detection (ON). 

3 To set an audible feedback, select the Tools > Options > 
DMU Fitting from the main menu. Under the DMU 
Manipulation tab, activate or de-activate the Clash 
Feedback as shown.

2 The elements involved in the collision will be 
highlighted in the 3D viewer and manikin 
motion will stop by activating the settings 
Stop on collision (see next icon). 

The clash detection activates or deactivates automatic clash detection in a simulation
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1. Select the Simulation Icon and pick in the 
list  the object that you want to simulation.

3. In the specification tree, 
a new node will be 
created called 
Simulation.

Movement of the manikin can be saved using two different functions:  Simulation  OR 
Track

2. Move the manikin using the 
Forward kinematics and click 
Insert for every desired frame 
and click Ok when completed.

Double click the items and use 
the keys to run the simulation

4. Generate a Replay.  
The replay will 
appear in the 
Specification tree.

5. Real Video can be generated 
for the manikin:  Need to select 
the simulated object:  Manikin

A simulation can be done for an object  
(Inserted inside a shuttle). Run the simulation 
of the object and put a constraints between the 
hand an the object.

Performing a Simulation (1/2)
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Double click the items 
and use the keys to 
run the simulation.

1. Select the track Icon.

3. Using the compass, 
move the segment and 
record each frame and 
click OK.

Movement of the manikin can be saved using two different functions:  Simulation  OR Track

2. Pick one of the seven control points 
of the manikin:  2 Hands, 2 Feet, 
Hip, Neck and line of sight.

4. Generate a Replay.  
The replay will appear 
in the Specification 
tree.

5. Real Video can be generated for the 
manikin:  Need to select the 
simulated object:  Manikin

A simulation can be done for an 
object  (Inserted inside a shuttle). 
Run the simulation of the object 
and put a constraints between the 
hand an the object.

Select the type of interpolation 
between the frame.

Performing a Simulation (2/2)
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Manikin’s Body Dimension
You will become familiar with the anthropometry of the manikin :

• Introduction of the Human Activity Analysis workbench

• Editing the accommodation

• Changing the anthropometrics variables

• Creating boundary manikins
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1. From  the main top menu.

2. By clicking on the following icon 

3. By double clicking on the anthropometry in the specification tree.

Accessing the Human Measurement Editor Workbench

In this workbench, there are six default population of manikins, but you can manually 
create specific manikins according to your data. The 103 anthropometrics variables on 
the manikin can be modified or a smaller number of 'critical' variables can be 
manipulated. In that case, the Editor will determine the rest of the value according to 
the predefined correlation. 
Accessing the workbench
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Human Measurements Editor - Accessing the Workbench

This is the toolbar for

Returns to the previous workbench 

Switches Gender

Population 

Applies a Posture

Displays the variable list

Filter 

Interpolation

Display 

Descriptions 

Load manikin's attributes 
from a catalog 

Save manikin's attributes in catalog 

Reset 
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1. In this workbench, you can 
change the gender, the 
population directly using the 
following icon.

3. Once you have identified the critical 
variable, the first thing to do when 
you want to generate non-standard 
manikins is to select the type of 
interpolation and the percentage of 
accommodation. Pick Multinormal 
and 90 %. 

2. Use the Filter, Posture and 
View panel in order to select 
different anthropometrics  
variables

A best compromise would allow you to accommodate 
most of the population at the minimum cost.  Usually 
an accommodation rate between 80and 90% 
represent a good compromise.

Editing the Accommodation

This concept consists to the definition of the percentage of accommodation of the target 
population. This function is mainly used when you want to do not want to accommodate the 
entire population. The cost of a design is more important when you try to accommodate the 
tallest and the smallest at the same time.
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After changing the type of 
management to manual you 
can input the value you want

Of course, the software will 
change all the others values to 
the most probable.  It will also 
indicates the limits of the 
variable.

This is the posture used to input the data, it 
better to reflect the posture used in the scene

Changing the Anthropometric Variables

This concept consists change the value of different anthropometrics variables within  the limits 
of the target population. This function is mainly used you do not want to work with standard 
manikins.  A 50th manikin might have different arm length and this later might be crucial for 
your work station.

1. In the following 
widow, you can select 
and double-click on 
any critical variables.

or select  the edit variable 
icon.
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2. The generation of boundary 
manikin considers the mean, 
the standard deviation and  
correlation between each 
variable.  This information is 
available in the SWS file 
within the online 
documentation.

1. Identify the critical 
variable for your 
workstation.

This concept consists to generate extreme manikins for a specific number of variables and for 
a specific percentage of the target population. This function is mainly used when the standard 
manikin (5,50 and 95th) are not enough for your analysis. 

3. Organize the variable in order to define 
the less correlated variable using a 
matrix.

Creating Boundary Manikins (1/2)
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1. Check the minimum and the maximum value 
for each variable.

2. Always by following the sequence, you will 
generate all the minimum and maximum 
value of each critical variable. 

3. Each time you have complete a sequence, 
the result is boundary manikin that you can 
save into a catalog.

Creating Boundary Manikins (2/2)
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Posture Evaluation
You will become familiar with the analysis of the manikin’s postural information

• Introduction of the Human Activity Analysis workbench

• Editing the range of motion

• Displaying the postural score

• Gathering and analyzing the results
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1. From  the Main Top Menu 

OR

2. Double clicking directly on a manikin’s segment

Accessing the Human Posture Analysis Workbench

This workbench allows you to analyze local and global postures, preferred angles and 
comfort. The color code and score provides postural information for all segments of 
the manikin and also permits to optimize the posture. According to scientific 
documentations, a catalog of preferred angles or angular limitations can be created for 
special population or predefined scenario. 

Accessing the workbench
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Human Posture Analysis Toolbars

These are the toolbars and icons for

Edits the angular limitations 
and the preferred angles

Optimizes the angular limitations 
according to the best preferred angles

Sets the angular limitations according 
to a percentage between 0 and 100

Locks the active DOF

Removes the angular limitations

Reset angular limitations

Customized Joint

Opens the Postural Score Panel

Finds the posture which maximizes 
the postural score
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Editing the Range of Motion (1/4)

1

Those functions allows you to define inside a specific range of motion the best zone to conduct a 
designed task.  The criteria of the zone can be: Comfort, force, etc. This function is mainly used when 
you want to evaluate the posture of various manikins inside a workstation.  To realize a unique task, 
the posture of the manikins might be different according to their dimensions.  In this case, their 
comfort will be different as well as their energy, etc.

Angular limitations and Preferred angles

This function is mainly used when you want to evaluate the posture of various manikins inside a 
workstation.  To realize a unique task, the posture of the manikins might be different according to 
their dimensions.  In this case, their comfort will be different as well.

Using the following Icon, the range of motion (Angular limitations) and the criteria zone (Preferred 
angles) can be modified according to your specific scenario or manikin’s characteristics
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Editing the Range of Motion (2/4)

2

3

4

The default range of 
motion is displayed in 
this panel (50% of the 
population). The bigger 
the range of motion 
smaller is the 
accommodation (only the 
elite are really flexible)

5

6

Angular Limitations allows you to set restrictions on the upper and lower limits of 
movement (in degrees) on a particular DOF of the manikin.

Edit the limit (Angular limitation) by double 
clicking on them directly OR with the 
contextual menu and select Edit

To modify the angular limitations, you 
have to Select 'Activate manipulation' 
and change the limit

Save the angular limitation in a 
catalog using this icon.

To reset the angular limitations, open 
the dialog box and select the angular 
limitation you want to reset.

Using the following icon, you can 
remove all angular limitation on 
selected segments

OR
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Editing the Range of Motion (3/4)

You can add or remove preferred 
angles for each DOF of the articulation

7

Preferred Angles allows you to create or edit preferred angles within the whole 
manikin range of motion. For example, it can refer to areas where the manikin 
would be comfortable, stronger or be in a safe posture.

8

9

You can also limit or optimized 
the range of motion according 
to the preferred angles.

Or simply lock completely the 
mobility of a joint.

10

By selecting the segment and 
(ctrl key) on the preferred angles 
node in the Specification tree, 
you can do a Mirror Copy of 
those preferred angles.

You can save those preferred angles in 
a catalog by selecting the Preferred 
angles node in the specification tree.

In the Preferred Angles dialog box, the 
characteristics of  each preferred angles 
must be detailed according to the 
scenario
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Editing the Range of Motion (4/4)

The Customize joint function groups segments on the upper body (including the spine 
and the head). This creates a new segment for the Postural Score analysis. This will 
give more flexibility for analyzing the posture of the trunk. It allows you to create virtual 
segments of the pelvis, trunk, neck and head on which you will be able to edit preferred 
angles with a score. 

Using the customized joint function, you can create virtual joint with a set of upper body segments 
(including the spine and the head). These virtual Segments can be created for any Degree of Freedom 
(DOF). Then, you will be allowed to specify standard Preferred Angles with a score. 

11

Options:

Select Whole Spine to score all vertebrae as a single element.
Select Each Vertebras to score each vertebra individually.
Select Whole Hand to regroup each finger into a global element.
Select Each Fingers to score each finger individually. 
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percentages in list form. If you choose the Chart display, 
scores will be displayed in chart form.

Displaying the Postural Score (1/3)
The Postural Score Analysis feature is used to evaluate the manikin's posture. Once the 
preferred angles have been specified or loaded from a library, you can evaluate the 
posture using the postural score function.

By opening the postural score panel, the Postural Score 
Analysis dialog box is displayed with the Display List as the 
default

The following information is displayed according to the 
selected Display type:

Global Score – this item is the total posture score for all 
segments combined.
Current Score – this item is the average score of all 
items in the current list.
Selected Score – this item is the posture score for all 
selected items on the multi-list.
Favorites – this item is customizable and displays all 
preferred angles, even if they have never been edited.
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Displaying the Postural Score (2/3)

Under the manikin’s properties it’s possible to 
change the coloring options

Use the Segment coloring to display color on the manikin’s 
segment according to the score of the preferred angle

By activating the coloring, you can 
get highlights for the worst case.

Active: check if you want to activate the coloring. 
All: activates the coloring. 
All but Maximum Scores: activates the coloring on all 
segments except those with scores at their maximum.

This feature can be used, for instance, to display colors 
only if the manikin goes out of its zone according to the 
score. 

Element to color: These check boxes are used to select 
the parts that will change color.
Degree of Freedom: This combo is used to choose the 
degree of freedom to activate.
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Displaying the Postural Score (3/3)

By using this icon, you can find the posture which 
maximizes the postural score that you have edited before

The function Find the Posture which maximizes the Postural Score changes the position of the 
body so as to maximize the global postural score of the manikin.

Only the edited preferred angles are saved in a catalog. For this reason, it’s 
possible to load different preferred angles on the same manikin. You can keep the 
previous preferred angles if it’s according to different segment or DOF.

The score that is assigned on a zone is the only indicator of a preferred 
angle. Specific Color, name is not an indicator of preferred angles.



Student Notes:

Human Modeling
����������	��

Copyright DASSAULT SYSTEMES 69

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

This concept consist in gathering all different types of results into a single document. 
Analyzing the posture using a unique database might minimize the accuracy of your 
analysis. This approach allows to gather different results in order to obtain a more 
objective analysis.

Here different population

Here different manikin 
(standard, boundary)

Here different analysis 
database

Gathering and Analyzing the Results
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Standard Ergonomic Analysis
You will become familiar with the use of standard ergonomic analysis

• Introduction of each workbench

• RULA ergonomic analysis 

• Lift /lower ergonomic analysis 

• Push/pull ergonomic analysis 

• Carry analysis 

• 3D Biomechanics
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This workbench allows investigation between the manikin and the working 
environment. All the analysis (RULA, lifting, lowering, pushing, pulling and carrying) are 
based on scientific ergonomics analysis. Those analysis help to identify critical task 
and evaluate the manikin’s action. 

Accessing the Human Activity Analysis Workbench

Accessing the workbench
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RULA Analysis

1. The RULA analysis is mainly use for static 
posture.  The analysis record the current 
posture of the manikin and once the 
specifications have been input, RULA 
provides you with a Score

2. In some case, the record of the manikin’s 
posture might be different than from a real 
worker.  At this time, you can change 
manually some input in order to reflect with 
more accuracy the reality

3. The score (1-7 is associated with a specific 
color code (green to red ) and a comments. 

4. Once the specifications have been input in 
the panel, Create a report and add RULA or 
RULA detailed in the report . 

5. Click update when ever you want to compile 
a RULA analysis and out put in the Report.  

3

1

1

2

4

5

1

The RULA (Rapid Upper Limb Assessment) system was developed at the University 
of Nottingham's Institute for Occupational Ergonomics (Reference: Lynn McAtamney
and E. Nigel Corlett, RULA: A Survey Method for the Investigation of Work-related 
Upper Limb Disorders). It was developed to investigate the exposure of individual 
workers to risks associated with work-related upper limb disorders. 
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Lift / Lower Analysis (1/2)

This concept consists in three different analysis: NIOSH 81, NIOSH 91 and 
Snook&Ciriello. Those analysis are standard matrix that analyze the current posture 
of the manikin and some specifications such as initial posture, final  posture, 
duration, repetition, etc. Those analysis are mainly used for lifting and lowering 
tasks.  Each of them are using different specifications and provide you with specific 
results.

Once you have identified two postures into the lift and lowering panel, 
you can conduct 3 different lifting and lowering analysis: NIOSH 81, 
NIOSH 91 and Snook& Ciriello.

NIOSH 81 is mainly for symmetric tasks and provides you with two
recommended weights.
Based on different population SAMPLE, NIOSH 91 allows to 
simulate trunk rotation and provide one recommended weight.
Snook&Ciriello allows you to introduce different grabbing 
condition and provide you with two recommended weights and a 
Lifting Index (current lifted weight/recommended weight).

1
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Specifications (depending of the guidelines choice)
1 lift every: Increase or decrease the value according to the lift frequency. 
Duration: Duration of the work (hours per day). Occasional if the value is one hour or less 
continuous if the value is 8 hours

Coupling condition: Quantify the quality of the hand-to-object. (Good, Fair or Poor)
Good - a comfortable grip in which the hand can easily wrap around the object 
Fair - a grip in which the hand can be flexed about 90 degrees. 
Poor - when the  object is hard to handle (irregular, bulky, sharp edges, etc.) 
Object weight: Enter the load weight. This value is used for the lifting index calculation. 
Population sample: Three population percentiles are provided: 90th, 75th, and 50th.

Score
Origin: This result is based on the initial posture of the manikin. 
Destination : This result is based on the final posture of the manikin
Action Limit (AL): Represents the weight below which the task could be considered as 
reasonably safe. 
Maximum Permissible Limit (MPL): Represents a limit above which the lifting task is 
considered as hazardous and requires engineering controls. 
Maximum Acceptable Weight: The weight that can be handled with reasonable safety
Recommended Weight Limit (RWL): Load weight that healthy workers can lift over a 
certain period of time without risk. 
Lifting Index (LI): Relative estimation of the level of physical stress

Lift / Lower Analysis (2/2)

Place the manikin in the first posture, click initial in the panel and click Record/modify button, perform 
the same operation for the final postures. By toggling  the buttons initial and final the postures can be 
automatically updated and double checked.

2

3 A report of these analysis can be generated automatically. The access to update the report is 
specific to these analysis because initial and final posture need to be identified manually.
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Smaller is the weight, bigger 
is the percentage of the 
population that can perform 
the task. 

Snook & Ciriello provides 
you two scores:  Initial force 
and Sustained force.

2. Considering the current posture 
of the manikin, input the 
specifications (Distance of push, 
distance of pull, the frequency 
and the population sample)

3. Once the specifications 
have been input in the 
panel, Create a report and 
add PUSH/PULL detailed in 
the report .  

4. Click update when ever you want 
to compile a RULA analysis and 
out put in the Report.   

1. Once the pushing posture has 
been identifies, activate the 
Push-Pull Analysis icon

Push / Pull Analysis

This analysis is a standard matrix that analyze the current posture of the manikin and 
some specifications such as duration, distance, etc. Those analysis are mainly used to 
evaluate the recommended effort that should be deployed when a worker is pushing or 
pulling on a kart in a specific posture.
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Carry Analysis

1. Select the desired 
posture for carrying the 
object.

2. Activate the carry 
analysis.

3. Input the specifications 
(Distance of push, 
distance of pull, the 
frequency and the 
population sample.

4. Once the specifications 
have been input in the 
panel, Create a report 
and add Carry in the 
report.

5. Click update when ever 
you want to compile a 
RULA analysis and out 
put in the Report.

This analysis is a standard matrix that analyze the current posture of the manikin and some 
specifications such as duration, distance, etc. Those analysis are mainly used to evaluate 
the recommended effort that should be deployed when a worker is pushing or pulling on a 
kart in a specific posture.

Depending of the manikin’s posture, 
the Maximum Acceptable Weight (in 
the score section) is different.
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3. Activate the biomechanics 
analysis.

Considering the current posture of the manikin.  
The stress on several joints can be evaluated 
efficiently.  The load can be apply for different 
contexts.

Several types of result output 
are available in each tab. 

1. In Human builder Workbench, 
create loads on the hands of 
the manikin.  Only one load can 
be created at the same time.

2. Input the magnitude and the 
orientation of the loads.

4. Once the specifications have been input in the 
panel, Create a report and add  Biomechanics 
in the report   (Select which output).

5. Click update when ever 
you want to compile a 
RULA analysis and out put 
in the Report.   

3D Biomechanics Analysis

Contrary to the standard analysis (NIOSH, Snook&Ciriello, etc.), the 3D Biomechanics analysis 
is the more flexible and accurate analysis for exertion. It allows you to calculate the 
compression spine, moment, shear and compare it with recognized standard. It can be used for 
an unlimited case study (push, pull lift, twist, etc ).
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Course Sum Up

In this course you have seen :
Forward and Inverse Kinematics
Constraints
Standard pose
Attach object
Catalogues and libraries
Range of motion 
Preferred angle
Anthropometrics variable
Boundary manikins
Simulation and track
Reach function and reach envelop
Vision
Various ergonomics analysis


